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Purpose and audience 

With faster tools and integrated 2D and 3D capabilities, ArcGIS Pro will streamline your GIS 

projects. ArcGIS Pro is a different experience. It introduces a project-based file structure, 

terminology changes, and brand-new tools and capabilities (which you will very likely love 

once you get used to them). This document helps prepare experienced ArcMap users to be 

productive right away. You will learn essential ArcGIS Pro terminology and get familiar with 

the ribbon-based user interface. The document highlights key differences in mapping, 

editing, and geoprocessing workflows and demonstrates new and streamlined capabilities 

that will help you complete your GIS work more quickly and easily than ever before. 

 
The audience for this document are experienced ArcMap users who are preparing to 

migrate to ArcGIS Pro. 

 
 

Abbreviations 

 
AeHIN  Asia eHealth Information Network 

Esri  Environmental Systems Research Institute 

GIS  Geographic Information System 

HGLC  Health GeoLab Collaborative 

SDGs  Sustainable Development Goals 
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1. Background 

The Health GeoLab Collaborative (HGLC)1 is a collective of institutions and individuals 
sharing the same vision - for low- and middle-income countries in Asia and the Pacific to 
fully benefit from the power of geospatial data and technologies to reach the health-related 
SDG 3 - and ready to engage their respective skills, experience, and resources to achieve it. 
 
The HGLC has been established and builds on the work done as well as the network and 
documents developed through the activities of the AeHIN GIS Lab over the 2016-2017 
period. 
 
The HGLC uses the 4Ts (Training, Tooling, Testing and Teaming) approach to strengthen in-
country capacity. The present starter kit has been developed as part of this approach and 
with the objective to be used by the largest number of users possible. 
 
This starter kit is a living document made to evolve based on the inputs received from the 
users. Please therefore don't hesitate to contact us at info@healthgeolab.net if you have 
any suggestions for improvement. 
 
Should you use this document as part of your activities and would like to have your 
organization recognized as one of document's users, please contact us at the email address 
provided above. 
 

2.  Introduction  

ArcGIS Pro, the new connected desktop, advances desktop GIS by providing a modern 
2D/3D user experience not only for performing powerful analysis but also for creating 
beautiful maps. ArcGIS Pro is a premier client of the ArcGIS platform and an essential 
companion to ArcGIS Enterprise and ArcGIS Online. It is fully integrated into the Web GIS 
pattern of working with web layers, web maps, and web scenes. 
 
This multi-threaded 64-bit application is a project-centric application with a contextual 
interface and uses the same familiar concepts as ArcMap – maps, layers, and basemaps. The 
challenge is to find familiar commands and follow familiar workflows in a redesigned 
application. The drop-down menus, toolbars, and dialog boxes in ArcMap are replaced by 
the ribbon and panes in ArcGIS Pro. 
 
This document will provide a high-level overview of the application design and user 
interface and familiarize you with common workflows in ArcGIS Pro. 
 

3. ArcGIS Pro Terminology 

Below is a high-level overview of essential terminology that is new to ArcGIS Pro. For a more 
detailed ArcGIS Pro Terminology Guide, please visit:  
 
http://www.esri.com/library/brochures/pdfs/arcgis-pro-terminology-guide.pdf  
 

                                                           
1
 http://healthgeolab.net 

file:///C:/Users/juli7742/AppData/Local/Box/Box%20Edit/Documents/E_8u2rJ6N0KMuAQBgKAQ2Q==/info@healthgeolab.net
http://www.esri.com/library/brochures/pdfs/arcgis-pro-terminology-guide.pdf


 

6 

 

Project —A collection of related GIS resources such as maps, scenes, layouts, datasets, 
tools, connections, and tasks. Most project items are stored in the project file (.aprx). Every 
project has an associated geodatabase (.gdb) and toolbox (.tbx). These are stored externally 
to the project file but typically in the same system folder. 
 

View —A window containing a representation of data such as a map, layout, or table. 
Multiple views can be open at the same time. The active view is the primary work area of 
the application. 
 

Map —A project item used to display and work with geographic data in two dimensions. 
 

Scene —A project item used to display and work with geographic data in 3D. Scenes can 
be viewed in global mode (for large geographic areas) or local mode (for small geographic 
areas). 
 

Basemap —A layer of background reference information, such as topography or imagery, 
on which other thematic layers are displayed. 
 

Layer —A visual representation of a collection of geographic features that are usually of 
the same thematic type, such as cities, parks, or roads. Some layers represent measured or 
remotely-sensed properties of surfaces, such as elevation, temperature, or land cover. Maps 
and scenes are composed of one or more layers. 
 

Geoprocessing —A framework and set of tools for analyzing, manipulating, and managing 
geographic data. 
 

Task —A set of steps that guide you through an ArcGIS Pro workflow. 
 

Layout —A collection of map elements organized on a virtual page designed for map 
printing. 
 

Portal —A connection to ArcGIS Online or ArcGIS Enterprise. In ArcGIS Pro, you sign in to 
a portal to share your work and access content shared by others. 
 
 

4. About ArcGIS Pro 

ArcGIS Pro is the latest professional desktop GIS from Esri. With ArcGIS Pro, you can view, 
explore, analyze, edit, and share your maps and data. An ArcGIS Pro project can contain 
many maps and layouts as well as tables, charts, and other items. 3D capabilities are native 
to ArcGIS Pro; any 2D map can be converted to a 3D scene. The sections below introduce 
basic elements of the user interface and important terms. You will build on this knowledge 
as you use the application, read the help resources, and complete tutorials. 
 

4.1. Projects 

In ArcGIS Pro, a body of related work—consisting of maps, layouts, data, tables, tools, and 
other resources—is organized in a project. By default, a project is stored in its own system 
folder. Project files have the .aprx extension. 

http://pro.arcgis.com/en/pro-app/help/projects/terminology-for-working-with-projects.htm
http://pro.arcgis.com/en/pro-app/help/mapping/navigation/introduction-to-linked-views.htm
http://pro.arcgis.com/en/pro-app/help/mapping/map-authoring/maps.htm
http://pro.arcgis.com/en/pro-app/help/mapping/map-authoring/scenes.htm
http://pro.arcgis.com/en/pro-app/help/mapping/map-authoring/web-map-basemap-layer.htm
http://pro.arcgis.com/en/pro-app/help/mapping/map-authoring/maps.htm#ESRI_SECTION1_6D77701DC377498EA068D983D18B4D86
http://pro.arcgis.com/en/pro-app/help/analysis/geoprocessing/basics/what-is-geoprocessing-.htm
http://pro.arcgis.com/en/pro-app/help/tasks/whatistask.htm
http://pro.arcgis.com/en/pro-app/help/layouts/layouts-in-arcgis-pro.htm
http://pro.arcgis.com/en/pro-app/help/projects/available-online-resources.htm


 

7 

 

When you start ArcGIS Pro, you can create a new project or open an existing project. A new 
project can either be blank or based on a template file (with the .aptx extension) (Figure 1). 
A project based on a template will open with the content specified by the template. For 
example, a project created from the Map template includes a map view with a basemap 
layer. 
 

 

Figure 1: On the ArcGIS Pro start page, you can open recent projects, browse to 
other projects, or create new projects. 

 

Every project has its own geodatabase (the project geodatabase) for storing data and its 
own toolbox (the project toolbox) for storing models, scripts, and other tools. These items 
are stored in the project's system folder along with the project file. 
 
Other items that belong to the project, such as maps, layouts, tables, charts, and resource 
connections, are stored in the project file. 
 
Items that you want to reuse in multiple projects can be marked as project favorites. 
 

4.2. ArcGIS Pro user interface 

The main parts of the ArcGIS Pro interface are the ribbon, views, and panes. For a hands-on 
introduction, try the Introducing ArcGIS Pro quick-start tutorial. 
 

4.2.1. Ribbon 

ArcGIS Pro uses a horizontal ribbon at the top of the application window to display and 
organize functionality into a series of tabs (Figure 2). Some of these tabs (core tabs) are 
always present. Others (contextual tabs) appear as needed when the application is in a 
particular state. For example, a set of contextual Feature Layer tabs appear when a feature 
layer is in use. 
 

http://pro.arcgis.com/en/pro-app/get-started/introducing-arcgis-pro.htm
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Figure 2: ArcGIS Pro ribbon 

 

Table 1: ArcGIS Pro ribbon elements 

 
You can customize the ribbon and the Quick Access Toolbar by right-clicking on a tool on the 
ribbon and choosing the option to add it to the Quick Access Toolbar (Figure 3). 
 

 

Figure 3: Customizing the Quick Access Toolbar 

 

4.2.2. Views 

A view is a window for viewing and working with a representation of your data (Figure 4). 
Maps, scenes, tables, layouts, and charts are all views. A project may have many views, 
which can be opened and closed as needed. Different views can be open at the same time, 
but only one is active. The active view affects which tabs appear on the ribbon and which 
elements are displayed in panes, such as the Contents pane. 

http://pro.arcgis.com/en/pro-app/get-started/customize-the-ribbon.htm
http://pro.arcgis.com/en/pro-app/get-started/quick-access-toolbar.htm
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Figure 4: An ArcGIS Pro map view 

 

 

Table 2: ArcGIS Pro View elements 

4.2.3. Panes 

A pane is a dockable window that displays the contents of a view (the Contents pane), the 
contents of a project (the Catalog pane) or commands and settings related to an area of 
functionality, such as the Symbology and Label Class panes (Figure 5). 
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Figure 5: ArcGIS Pro Content and Catalog panes 

 
While basic commands are available on the ribbon, panes offer advanced or complete 
functionality. Panes may have rows of text and graphical tabs that subdivide and organize 
their functionality. 
 

 

Figure 6: ArcGIS Pro pane 

 

 

Table 3: ArcGIS Pro Pane elements 
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5. Migrating from ArcMap to ArcGIS Pro 

Most of the functionality available in ArcMap is also available in ArcGIS Pro. The challenge is 
to find familiar commands and follow familiar workflows in a redesigned application. The 
drop-down menus, toolbars, and dialog boxes in ArcMap are replaced by the ribbon and 
panes in ArcGIS Pro.  
  

5.1. User interface 

Two aspects of ArcGIS Pro that may take time for ArcMap users to adjust to are the user 

interface and data management operations. For an introduction to basic data management 

in ArcGIS Pro, see Catalog pane, catalog view, and browse dialog box. 

 

 

Figure 7: The ArcGIS Pro user interface includes a ribbon, various kinds of views, and panes. 

http://pro.arcgis.com/en/pro-app/help/projects/the-project-pane.htm
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Table 4: ArcGIS Pro user interface components 

 

5.2. Add existing work 

5.2.1. Import a map document 

You can import an ArcMap map document on the Insert tab of the ribbon. Click Import Map 
and search or browse to your file on the Import dialog box (Figure 8). 
 

 

Figure 8: Importing map from ArcMap 
 

When you import a map, the map document opens as a map view in your ArcGIS 
Pro project. If your map document has multiple data frames, each data frame becomes a 
separate map. The additional maps can be opened from the Catalog pane, under Maps 
(Figure 9). 

http://pro.arcgis.com/en/pro-app/help/projects/add-maps-to-a-project.htm#GUID-B5D6CDC1-A150-4FEF-833F-F6AAC0D92890
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Figure 9: Multiple data frames from ArcMap as separate maps 

 
The layout of your map document is also imported. If your map document doesn't have a 
layout, a default layout is created from the map data. 
 

When you import a map, a blue dot appears on the Notifications button  above the 
ribbon (Figure 10). Open the notification to see messages about the import process. 
 

 

Figure 10: Blue dot appears on the Notification button when a map is imported 

 

Click the Notifications button . 
 
In the Notifications pane, hover over the message to display a View Results link. 
 
Click View Results. 
 
A browser tab opens (referencing a local file) with import result messages. 
 
Most of the time, your imported map will look exactly, or almost exactly, like the original 
map document. However, ArcGIS Pro has a different drawing engine than ArcMap and this 
may cause subtle visual differences in the imported map. 
 

If ArcGIS Pro can't access a dataset in the imported map document, an indicator  appears 
next to the layer name in the Contents pane. This means you need to repair the layer. 

http://pro.arcgis.com/en/pro-app/help/projects/arcgis-pro-notifications.htm
http://pro.arcgis.com/en/pro-app/help/projects/drawing-behavior-in-arcgis-pro.htm
http://pro.arcgis.com/en/pro-app/help/mapping/layer-properties/repair-broken-data-links.htm
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No link is maintained between the ArcGIS Pro map and the original ArcMap map document. 
Changes you make in ArcGIS Pro are not reflected in the map document. 
 
Although you can import and use ArcMap documents with ArcGIS Pro, you cannot 
export ArcGIS Pro items as .lyr, .lpk, .mxd, .sxd, or .3dd files to ArcMap since not all 
functionality is compatible. 
 
Try the Import an ArcMap document quick-start tutorial to see how the process works. 
 

5.2.2. Add data, toolboxes, models, and scripts 

You can add folder connections, databases, server connections, locators, toolboxes, styles, 
and other resources to your project from the Insert tab on the ribbon (Figure 11). 
 

 

Figure 11: ArcGIS Pro Insert tab 

 

Click Add Item  to add a resource that you want to be readily accessible in any project. It 
will appear on the Favorites tab in the Catalog pane. 
 
Once a resource is added to a project, it is available from the Catalog pane or catalog view. 
See Supported data types and items for a list of items that can be added to an ArcGIS 
Pro project. 
 
Tip: You can also add resources by right-clicking an item category, such as Folders, in the 
Catalog pane or catalog view. 
 
Your ArcMap tools, models, and scripts can be used in ArcGIS Pro but may need to be 
modified. Run the Analyze Tools For Pro geoprocessing tool to check the compatibility of a 
script or toolbox. 
 
ArcGIS Pro uses Python 3, so scripts that run in ArcMap need to be modified. For more 
information, see Python migration from 10.x to  ArcGIS Pro and Migrating from 
arcpy.mapping to ArcGIS Pro. Application-level .NET add-ins written for ArcMap will not run 
in ArcGIS Pro. 
 
Import styles  
 
ArcMap, ArcGlobe, and ArcScene styles (.style files) cannot be used directly in ArcGIS 
Pro projects. However, many of these styles have been converted to ArcGIS Pro style format 
(.stylx) and can be added from ArcGIS Online. When you add a style from ArcGIS Online, it is 
copied to your computer and you can continue to use it offline. 
 

http://pro.arcgis.com/en/pro-app/get-started/migrate-content-to-arcgis-pro.htm
http://pro.arcgis.com/en/pro-app/help/projects/connect-to-resources.htm
http://pro.arcgis.com/en/pro-app/help/projects/project-favorites.htm
http://pro.arcgis.com/en/pro-app/help/projects/supported-data-types-and-items.htm
http://pro.arcgis.com/en/pro-app/tool-reference/data-management/analyzetoolsforpro.htm
http://pro.arcgis.com/en/pro-app/arcpy/get-started/python-migration-for-arcgis-pro.htm
http://pro.arcgis.com/en/pro-app/arcpy/mapping/migratingfrom10xarcpymapping.htm
http://pro.arcgis.com/en/pro-app/arcpy/mapping/migratingfrom10xarcpymapping.htm
http://pro.arcgis.com/en/pro-app/help/projects/connect-to-a-style.htm#ESRI_SECTION2_8F616622F0174618BA8EC5D328E3CDC0
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You can also import a style from ArcMap, ArcGlobe, or ArcScene. Importing a style converts 
it from a .style file to a .stylx file. 
 

6. Common workflows 

6.1. Navigation 

Common map navigation tools are located on the Map tab of the ribbon in the Navigate 
group (Figure 12). 
 

 

Figure 12: ArcGIS Pro Map tab 

 

The Explore tool is active by default. When it is active, you can use the mouse buttons to 
navigate 2D maps and 3D scenes. For more information, see Navigation and Navigation in 
3D. For a guided experience, try the Navigate maps and scenes quick-start tutorial. 
 
In ArcMap, several tools are used for navigation and preliminary data exploration: Pan, 
Zoom, Identify, and HTML Pop-up. In ArcGIS Pro, the functionality of these tools is combined 
in the Explore tool. You can also use keyboard shortcuts for navigation. 
 

6.2. Feature identification 

Unlike ArcMap, ArcGIS Pro doesn't have an Identify tool. To identify a feature, make sure 

the Explore tool  is active. Click the feature to open its pop-up window. To identify several 
features, press the Control (Ctrl) key while dragging a box around them. 
 

6.3. Editing 

In ArcMap, you start an edit session to begin editing. In ArcGIS Pro, editing is always 
enabled. Editing tools are located on the Edit tab of the ribbon (Figure 13). For more 
information, see Editing in ArcGIS Pro. 
 

 

http://pro.arcgis.com/en/pro-app/help/projects/connect-to-a-style.htm#ESRI_SECTION1_6994EE9B9B85470BAAD371A046DE3B42
http://pro.arcgis.com/en/pro-app/help/mapping/navigation/navigation-in-arcgis-pro.htm
http://pro.arcgis.com/en/pro-app/help/mapping/navigation/overview-of-3d-navigation.htm
http://pro.arcgis.com/en/pro-app/help/mapping/navigation/overview-of-3d-navigation.htm
http://pro.arcgis.com/en/pro-app/get-started/navigate-your-data.htm
http://pro.arcgis.com/en/pro-app/help/mapping/navigation/keyboard-shortcuts-for-navigation.htm
http://pro.arcgis.com/en/pro-app/help/mapping/navigation/pop-ups.htm
http://pro.arcgis.com/en/pro-app/help/editing/overview-of-desktop-editing.htm
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Figure 13: ArcGIS Pro Edit tab 

 

  

Table 5: ArcGIS Pro Edit tab commands 

 

6.4. Metadata 

Metadata in ArcGIS format can be viewed and edited in ArcGIS Pro. It is not necessary to 
upgrade or import metadata in ArcGIS format. 
 
ArcGIS Pro supports the same metadata styles as ArcMap. In ArcGIS Pro, the default 
metadata style is Item Description. The style can be changed on the Metadata tab of 
the Options dialog box as follows: 
 
On the ArcGIS Pro start page, click About ArcGIS Pro. Alternatively, in an open project, click 
the Project tab. 

1. In the list on the left, click Options. 
2. On the Options dialog box, under Application, click Metadata. 
3. Click the Metadata style drop-down arrow and choose a style. 

 
Metadata for datasets and other items such as maps, layouts, and toolboxes is accessed 

from the catalog view  (Figure 14). The catalog view is open by default in new projects. It 
can also be opened from the View tab on the ribbon. 
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Figure 14: Metadata for a feature class displayed in the catalog view. 

 

When the catalog view is active, you can edit an item's metadata by clicking Edit  on 
the Home tab of the ribbon. 
 
Layer metadata is accessed from the layer properties. Right-click a layer in 

the Contents pane of your map and click Properties . In the Layer Properties dialog box, 
click Metadata (Figure 15). 
 

 

Figure 15: Layer metadata from an imported ArcMap document 

 
ArcGIS Pro layer metadata exposes more fields than ArcMap layer metadata. Therefore, 
when you import a map document, some layer metadata fields will be empty in ArcGIS Pro. 
Optionally, you can copy metadata from the layer's data source to the layer using 

the Copy button  . 
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For more information, see View and edit metadata. 
 

6.5. Geoprocessing 

In ArcGIS Pro, geoprocessing tools are accessed from the Analysis tab on the ribbon (Figure 

15). Click the Tools button  to open the Geoprocessing pane, where you can search for, 
open, and run geoprocessing tools (Figure 16). 
 

 

Figure 15: ArcGIS Pro Analysis tab 

 

 

Figure 16: Tools are run from the Geoprocessing pane. Click the Toolboxes tab on the pane to browse 

system toolboxes. 

 

You can also open many common tools directly from the Analysis gallery on the ribbon. 
 
For more information, see Geoprocessing quick tour, Geoprocessing options, and ArcGIS 
Pro tool reference. For an introductory experience, try the Use geoprocessing tools quick-
start tutorial. 
 

6.6. Tables 

To open a layer attribute table in ArcGIS Pro, right-click a layer in the Contents pane and 

click Attribute Table . 
 
When a layer attribute table is the active view in your project, a Data tab (under Feature 
Layer) and a View tab (under Table) appear on the ribbon. Both tabs have tools for working 
with the table (Figure 17). There are also tools on the table for common operations. 
 

http://pro.arcgis.com/en/pro-app/help/metadata/view-and-edit-metadata.htm
http://pro.arcgis.com/en/pro-app/help/analysis/geoprocessing/basics/customize-arcgis-pro-with-geoprocessing-tools.htm#ESRI_SECTION1_E9178E2101A346868938D158D25AE3E4
file:///C:/Users/juli7742/Desktop/EMCS%20documentationhttp:/pro.arcgis.com/en/pro-app/help/analysis/geoprocessing/basics/geoprocessing-quick-tour.htm
http://pro.arcgis.com/en/pro-app/help/analysis/geoprocessing/basics/geoprocessing-options.htm
http://pro.arcgis.com/en/pro-app/tool-reference/main/arcgis-pro-tool-reference.htm
http://pro.arcgis.com/en/pro-app/tool-reference/main/arcgis-pro-tool-reference.htm
http://pro.arcgis.com/en/pro-app/get-started/use-geoprocessing-tools.htm
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Figure 17: In this example, the table is a layer attribute table. The Data tab and the View 

tab also appear when you open a standalone table. 

 

To change a table's field properties, such as field names and aliases, visibility, and number 
formatting, open a fields view of the table. The fields view is a tabular layout of the table's 
fields. Each field is represented by a row, and each field property is represented by a 
column. You edit the fields view to change the field properties of the table (Figure 18). 

 

 

Figure 18: Fields: Regions is the fields view of the Regions table. 

 

To learn to work with tables, field views, charts, and pop-ups in ArcGIS Pro, try the Explore 
your data quick-start tutorial. 
 

6.7. Sharing 

To access portal items from ArcGIS Online or ArcGIS Enterprise, click the Portal tab in the 

Catalog pane and choose a repository—such as All Portal —to search or browse (Figure 
19). 
 

http://pro.arcgis.com/en/pro-app/help/data/geodatabases/overview/an-overview-of-fields.htm#GUID-D9D90AE9-1056-4DF5-9749-810C1C1AD977
http://pro.arcgis.com/en/pro-app/get-started/explore-your-data.htm
http://pro.arcgis.com/en/pro-app/get-started/explore-your-data.htm
http://pro.arcgis.com/en/pro-app/help/projects/available-online-resources.htm
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Figure 19: A search for tortoises in All Portal (all public content on ArcGIS Online) returns 

many items that can be added to a map or project. 

 

To share maps, layers, and projects from ArcGIS Pro to your portal, click the Share tab on 
the ribbon. 
 
If you can connect to multiple portals—for example, if you belong to more than one ArcGIS 
organization—you may need to manage portal connections to make sure you share content 
to the correct portal. 
 
For an introduction to sharing content in ArcGIS Pro, try the Share a web map and Create a 
project template quick-start tutorials. 
 

7. Common Questions About ArcGIS Pro 

Below are some of the common questions asked about ArcGIS Pro and their corresponding 
answers. 
 
Does ArcGIS Pro replace ArcMap? 
Yes. ArcGIS Pro will eventually replace ArcMap. We will continue to support and maintain 
ArcMap. However, our focus is on making ArcGIS Pro the world’s best desktop GIS. There 
are still some capabilities of ArcMap that are not yet in ArcGIS Pro, so some ArcGIS Desktop 
users will be using both ArcGIS Pro and ArcMap till Pro has everything you need to fully 
support your work. 

 
What is the retirement schedule for ArcMap? 
While Esri has moved most of its development efforts to ArcGIS Pro, we will continue to 
provide support and minor bug fixes in ArcMap for a long time (you can find the ArcMap 
Product Life Cycle on the Esri website). This means that users will be able to use legacy 
ArcMap applications and workflows long into the future. At the same time, all ArcMap users 
have the ability to use ArcGIS Pro in their desktop environment. There will be many sessions 
at the conference this year that show the new features and the advantages of migrating to 
ArcGIS Pro. 

http://pro.arcgis.com/en/pro-app/help/sharing/overview/share-with-arcgis-pro.htm
http://pro.arcgis.com/en/pro-app/help/projects/manage-portal-connections-from-arcgis-pro.htm
http://pro.arcgis.com/en/pro-app/get-started/share-a-webmap.htm
http://pro.arcgis.com/en/pro-app/get-started/create-a-project-template.htm
http://pro.arcgis.com/en/pro-app/get-started/create-a-project-template.htm
http://support.esri.com/Products/Desktop/arcgis-desktop/arcmap
http://support.esri.com/Products/Desktop/arcgis-desktop/arcmap
https://userconference2017.schedule.esri.com/schedule/1453757612
https://userconference2017.schedule.esri.com/schedule/1453757612
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When will ArcGIS Pro do what ArcMap does? 
Esri is steadily making progress on building out the functionality of ArcGIS Pro. The initial 
release involved basic mapping, editing, 3D visualization, geoprocessing/modeling 
capabilities, and integration with ArcGIS Online. ArcGIS Pro has had several updates over the 
last two years and will have an important new release (ArcGIS Pro 2.0) this summer that will 
include the following: 

 Project Favorites and a Catalog user experience 

 New analysis geoprocessing tools 

 Support for WFS as a native layer and support for service version from OGC web 
services 

 Support for migrating existing and creating new annotations 

 Layout with Grids and support for Charts on Layouts 

 Traverse tool for COGO feature creation 

 Ability to run multiple instances of ArcGIS Pro on the same machine 

 Improvements to the .NET SDK for developers 

 Additional functionality for the Task framework 

 Improved cartography 

This release will also provide the foundation for the implementation of the mapping and 
charting solution applications from Esri later this year and early next. The last two 
functionality areas we are working on a new data model and tools for network management 
(December) and parcel fabric (2018). You can see the Roadmap for ArcGIS Pro on GeoNet. 

 
Will I be able to use ArcGIS Pro with earlier versions of ArcGIS Desktop? 
Yes, Esri customers current on maintenance who are using earlier versions of ArcGIS 
Desktop will be able to use ArcGIS Pro. If you are not current on maintenance, you will need 
to get back onto maintenance to access ArcGIS Pro. Find out how to get back on 
maintenance at the Esri Maintenance Program page. 
 
Can I get ArcGIS Pro if I don't have a license for ArcGIS Desktop? 
No. ArcGIS Pro is part of the ArcGIS Desktop collection of applications, and only customers 
licensed and current on maintenance for ArcGIS Desktop have access to ArcGIS Pro. 
 
Does ArcGIS Pro have multiple license levels (i.e., Basic, Standard, and Advanced)? 
Yes. ArcGIS Pro is available in three versions that correspond to the ArcGIS Desktop license 
levels: Basic, Standard, and Advanced. More functionality is included in the progression 
from Basic to Standard to Advanced. 
 
Can I use my licensed ArcGIS Desktop extensions with ArcGIS Pro? 
Yes. Since ArcGIS Pro is part of ArcGIS Desktop, you are licensed to use the same extensions 
for ArcGIS Pro as you are with ArcMap (as available). The following extensions are available 
for ArcGIS Pro: ArcGIS 3D Analyst, ArcGIS Spatial Analyst, ArcGIS Network Analyst, ArcGIS 
Workflow Manager, and ArcGIS Data Reviewer. The extension licenses for ArcGIS Pro are 
managed using the same method you have chosen for your ArcGIS Pro license. 
 
 
 

http://www.esri.com/software/maintenance
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Does Esri provide training for ArcGIS Pro? 
Yes. Esri provides a number of free and paid training options for ArcGIS Pro. The courses are 
designed to help you get started and continue to be successful using this new addition to 
ArcGIS Desktop. Visit the Esri training catalog to find the course that fits your needs. 
 
Free training is also available at learn.arcgis.com. 
 
Is ArcGIS Pro included with ArcGIS for personal use? 
Yes. Esri has a personal-use option for full use of ArcGIS Desktop and ArcGIS Online for a 
very affordable price. Visit the ArcGIS for Personal Use Program page to take advantage of 
this amazing deal. 
 

8. Additional Resources 

There are several resources you can check out to learn more about ArcGIS Pro. Below are 
some of these resources. 

Documentation & Guides 

 Install options - http://pro.arcgis.com/en/pro-app/get-started/arcgis-pro-
installation-administration.htm  

 ArcGIS Pro Documentation - http://pro.arcgis.com/en/pro-app/  

 ArcGIS Pro Terminology Guide - http://www.esri.com/library/brochures/pdfs/arcgis-
pro-terminology-guide.pdf  

 Tips and tricks for transitioning from ArcMap to ArcGIS Pro - 
https://communityhub.esriuk.com/geoxchange/2017/6/15/helpful-tips-and-tricks-
for-transitioning-from-arcmap-to-arcgis-pro  

 A bunch of ArcGIS Pro tips - 
https://communityhub.esriuk.com/geoxchange/2017/4/7/a-bunch-of-pro-tips  

 

Training & Tutorials 

 ArcGIS Pro quick-start tutorials - http://pro.arcgis.com/en/pro-app/get-started/pro-
quickstart-tutorials.htm  

 Introducing ArcGIS Pro Tutorial - http://pro.arcgis.com/en/pro-app/get-
started/introducing-arcgis-pro.htm 

 Getting Started with ArcGIS Pro Web Course - 
https://www.esri.com/training/catalog/57630435851d31e02a43f007/getting-
started-with-arcgis-pro/  

 Going Pro: ArcGIS Pro Essentials for ArcMap Users Training Seminar - 
https://www.esri.com/training/catalog/590901ecdb250232197d2326/going-pro:-
arcgis-pro-essentials-for-arcmap-users/  

 Go Deeper with Data Analytics Using ArcGIS Pro and R Training Seminar - 
https://www.esri.com/training/catalog/596e5ab6b826875993ba4fd9/go-deeper-
with-data-analytics-using-arcgis-pro-and-r/  

http://training.esri.com/gateway/index.cfm?fa=search.results&searchterm=arcgis+pro
http://learn.arcgis.com/
http://www.esri.com/software/arcgis/arcgis-for-personal-use
http://pro.arcgis.com/en/pro-app/get-started/arcgis-pro-installation-administration.htm
http://pro.arcgis.com/en/pro-app/get-started/arcgis-pro-installation-administration.htm
http://pro.arcgis.com/en/pro-app/
http://www.esri.com/library/brochures/pdfs/arcgis-pro-terminology-guide.pdf
http://www.esri.com/library/brochures/pdfs/arcgis-pro-terminology-guide.pdf
https://communityhub.esriuk.com/geoxchange/2017/6/15/helpful-tips-and-tricks-for-transitioning-from-arcmap-to-arcgis-pro
https://communityhub.esriuk.com/geoxchange/2017/6/15/helpful-tips-and-tricks-for-transitioning-from-arcmap-to-arcgis-pro
https://communityhub.esriuk.com/geoxchange/2017/4/7/a-bunch-of-pro-tips
http://pro.arcgis.com/en/pro-app/get-started/pro-quickstart-tutorials.htm
http://pro.arcgis.com/en/pro-app/get-started/pro-quickstart-tutorials.htm
http://pro.arcgis.com/en/pro-app/get-started/introducing-arcgis-pro.htm
http://pro.arcgis.com/en/pro-app/get-started/introducing-arcgis-pro.htm
https://www.esri.com/training/catalog/57630435851d31e02a43f007/getting-started-with-arcgis-pro/
https://www.esri.com/training/catalog/57630435851d31e02a43f007/getting-started-with-arcgis-pro/
https://www.esri.com/training/catalog/590901ecdb250232197d2326/going-pro:-arcgis-pro-essentials-for-arcmap-users/
https://www.esri.com/training/catalog/590901ecdb250232197d2326/going-pro:-arcgis-pro-essentials-for-arcmap-users/
https://www.esri.com/training/catalog/596e5ab6b826875993ba4fd9/go-deeper-with-data-analytics-using-arcgis-pro-and-r/
https://www.esri.com/training/catalog/596e5ab6b826875993ba4fd9/go-deeper-with-data-analytics-using-arcgis-pro-and-r/

